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How to play The Amazon Trail
You must find cinchona and take it to the Inca King in Vilcabamba. As you play, read information carefully 
and make decisions based on what you read. Younger children may need help reading the information.

Getting started 

Canoeing upriver    

Exploring the rainforest    

Visiting landmarks, and talking and trading with people    

Ending your journey 



Getting started
The Amazon Trail has buttons you click to help you play the game. Click on the hotspots in the picture 
below to find out what the game buttons are for.



Start upriver
Click here to begin your journey upriver.



Talk to your guide
This is the Guide button. Click here to consult with your guide about your journey. You can change your 
pace or rations or you can rest for awhile. Click Adiós to return to the game.
 



Consult with your guide
Click the Guide button to talk to your guide. 

Click on the hotspots on the picture below for more information.



How are we doing?
Click here to see how long you've been traveling, what pace you are going, what rations you're eating, 
and how much food you have left. You can make decisions to change your pace or the amount of your 
rations based on this information.



Let's rest
Click here if you decide to rest; then choose how long to rest. Resting helps you recover from illness or 
injury.



Let's change our pace
Click here to change your traveling pace. You can choose either steady, strenuous, or grueling. The faster
you travel, the more likely you are to get sick or injured.



Let's change our rations
Click here to change the amount of rations you want to eat. You can choose from bare-bones, normal, or 
filling. The faster you travel, the more food you'll eat.



Return to the game
Click here to return to the game.



Check your supplies
Click the Supplies button to check your supplies. Check your supplies to find out if you're running out of 
food or whether you have spare supplies to trade. 

Click on the hotspots in the picture below for more information.



What supplies do you have?
It's very important to check your supplies. If you don't have a machete, you can't explore the rainforest. If 
you don't have a harpoon, you can't go fishing. If you're running out of food, you must find more by fishing
or trading.



What have you collected for the Inca King?
Click here to see what you have collected for the Inca King. You can collect up to 16 items.



How to turn the pages
Click here to turn the pages.



Study the map
This is the Map button. Click here to see a map of the Amazon Basin. You can find out exactly where you 
are and how you're doing. If you're traveling in the wrong direction, you can turn around. Point the cursor 
at places along the rivers on the map to see the names of rivers and cities. 



Consult the guidebook
Click on the Guidebook button to see the guidebook. It is full of useful information (and a few clues). You 
can read about plants, animals, people, places, trade items, and diseases.



Read the guidebook
Click on the Guidebook button to see the guidebook. It is full of useful information (and a few clues). You 
can read about plants, animals, people, places, items to trade, and diseases. 

Click on the hotspots on the picture below for more information.



Stop it
Stop it! That tickles.



Help!
Help! I'm drowning.



Index
Click here to see the guidebook index listing all the major topics.



Listen
Click here and you can hear the guidebook entry being read to you.



Talk to people
This is the Talk button. Click here to talk to the two people at each landmark; then click on the questions 
you want answered. You can trade with either of the people if you think they have something you need or 
can give to the Inca King, such as cinchona. When you've finished talking to one person, click the Talk 
button again and you can question the second person. 



Canoeing upriver
As you travel upriver, you can explore the rainforest, visit landmarks and talk to people, go fishing, or talk 
to your guide.    

Click on the hotspots in the picture below for more information.



How healthy are you?
The shorter the red area on the health indicator, the less healthy you are! If you're sick, you can rest. If 
you're running out of food, you can get some by trading (at landmarks) or fishing (on the river).



How to canoe
Point the camera wherever you want to go and the canoe follows. You'll never run aground--your guide 
will make sure of that! Try to avoid the little disturbances in the water. They're either whirlpools or sunken 
logs that may capsize your canoe. If you think you are traveling in the wrong direction, study the map to 
see where you are and choose "Let's turn around."



Explore the rainforest
If you have a machete, click the Explore button to explore the rainforest. 

Click on the hotspots in the picture below for more information. 



Climb up
Click here to climb higher up into the canopy.



Climb down
Click here to climb down to the forest floor.

Note: When the arrow is dimmed like this, you are already on the forest floor and can go no lower.



Move left
Click here to move to the left in the forest.



Move right
Click here to move to the right in the forest.



What's in the rainforest
Watch for tiny movements betraying the presence of an animal. When you spot something, move the 
camera on top of it and click. If you "get" it, you'll see a close-up picture of the animal. You can also take 
photos of interesting vegetation.



What's in your supply basket?
This is the Supply button. Click here to check your supplies, see what you've collected for the Inca King, 
or check the contents of your photo album.



What's in your photo album?
When you identify a plant or animal, a photo of it is put in your album. Click the Photo Album button to see
what's in your photo album. If you reach Vilcabamba, the Inca King gives you credit for each plant or 
animal in your album.

Click on the hotspots in the picture below for more information. 
 



Identifying plants and animals
The Inca King gives you credit for any plants and animals you identify. The more photos you have in your 
album, the more jewels you will get on your shield!



Take a photo
Click with the camera to take photos and identify plants and animals.
.



Return to the river
Click here to continue your canoe journey.



Go fishing



How to go fishing
Click the Fishing button to try your hand at catching exotic fish. You must have a harpoon in your supplies
to fish. Fishing (if you're successful) can supplement your food supplies. Aim the middle prong of the 
harpoon over the fish and click. 

Click on the hotspots in the picture below for more information. 



Keep it
Click here to keep the fish and add it to your food supplies. A photo of each fish you catch is put in your 
photo album.



Look it up
Click here if you're not sure whether the fish is safe to eat. Use the information in the guidebook to decide
whether to keep the fish.



Release it
Click here if you think the fish is too dangerous to keep.



Visiting landmarks
As you travel upriver, you stop at landmarks. You can talk to two people at each landmark and trade with 
them if you wish. To talk, click on one of the questions. To trade, click on "Do you want to trade?" 

Click on the hotspots in the picture below for more information. 



Return to landmark
Click here to return to the landmark.



Who is this?
This is Captain Pedro de Teixeira. He is one of the two people at this landmark. To talk to the other 
person, click the Talk button.



Talk to the other person
Click here to talk to the other person at a landmark.



What would you like to know?
You can ask a series of questions to find valuable information that may help you with your quest.



What do you want?
It's a good idea to trade with the people at landmarks. You never know who may have cinchona or 
something else the Inca King wants. Simply click on the item you want. 

Click on the hotspots in the picture below for more information.      



How to trade
When you have clicked on the item you want:

1. Browse through your possessions by clicking on the left- and right-arrows.
2. Click on the item you are willing to trade.
3. Click 1 (as in "I will trade 1 machete") to display a list of numbers.
4. Click on the number representing the number of items you are willing to trade.
5. Click "Is it a deal?". If your offer is accepted, click "It is a deal" and the item is added to your supplies. 

If the item is something the Inca King wants, it is added to the basket. If your offer is not accepted, 
increase the quantity of the item or try different trade items until you are successful. 

Click on the hotspots in the picture below for more information.



Look at your possessions
Click here to browse through your possessions until you find an item you want to trade. 



Choose a trade item
Click on the item you want to trade.



Don't trade after all
Click here if you decide not to trade.



Ending your journey
If you reach Vilcabamba, the Inca King honors you with a shield. If you have cinchona for the Inca King, 
your shield is gold; if you don't, your shield is bronze. The best eight shields are displayed in the Hall of 
Shields. 

Click on the hotspots on the picture below for more information.

 



What's on your shield?
Jewels on the shield represent the plants and animals you identified, the items you collected for the king, 
and the people you talked to on your journey. The more jewels on your shield, the more valuable it is! 
Click on your shield and the Inca King will tell you about the jewels.



Return to the title screen
Click here to see the shields in the Hall of Shields and the dream scene before returning to the title 
screen.



Facts About the Amazon River Basin

The Amazon Basin is an amazing place. Click on one of the topics below to see interesting facts about 
the Amazon.

The rainforest 

The Amazon River Basin 

People and places of Amazonia 
 
Fishing in the Amazon Basin 



The rainforest
Vegetation along the banks of the Amazon River is very dense because it gets plenty of sunshine. That's 
why, in The Amazon Trail, you need a machete to go exploring. Further away from the banks of the river,
the canopy blocks the sunlight (only 1% actually penetrates to the forest floor), so there is much less 
vegetation on the ground.

Animals living in the rainforest are well camouflaged and difficult to see. In fact, you are much more likely 
to hear them than see them. Until scientists began to use scaffold-and-rope systems to climb the trees, 
they couldn't study any of the animals living high in the canopy. As many as half of the earth's animal 
species may live in the rainforest canopies!

The entomologist (insect scientist) Edward O. Wilson once found 43 species of ants in one tree. 
Entomologists are continually discovering new species of insects in Amazonia. 

It is very rare to see a snake, and even more rare to be bitten by one.

Rainforest soil is very poor because most of the nutrients are contained in the living plants. Leaf litter on 
the rainforest floor is usually only one inch deep, and topsoil is only two inches deep. In temperate 
forests, leaf litter can be a foot deep, and topsoil, seven feet deep.

No one knows for sure, but there may be as many as 800,000 plant species in the Amazon rainforests, 
about 16% of the world's total. Whereas North American forests have approximately 20 species of plant in
a two-and-a-half acre area, the rainforest has between 40 and 50. It can be unusual to see two trees of 
the same species in one area.

Only 25% (one gallon out of every four) of the water in Amazonia ever leaves the basin; the rest 
evaporates and returns as rain. If this cycle of evaporation and precipitation is disrupted by cutting down 
too much of the rainforest, the rainforest will never be able to regenerate.



The Amazon River Basin
There are four basic types of rivers in the Amazon Basin:

· White-water rivers are clear, pure rivers in the slopes of the Andes mountains. 
· Brown-water rivers slowly collect sediment. The Amazon river is a brown-water river.
· Blue-water rivers are tributaries to the south of the Amazon river. They flow so slowly that the 

sediments sink to the bottom and collect in wide sections of the rivers.
· Black-water rivers are tributaries to the north of the Amazon river. They get their dark brown/black 

color from rotting vegetation in the water. The vegetation usually sinks to the bottom in swampy areas
before it reaches the main rivers.

At some points the Amazon River is more than 30 miles wide with many more islands and tributaries than 
appear in The Amazon Trail program. There are 10 tributaries over 10,000 miles long. One tributary, the 
Madeira River, is itself the fourth longest river in the world. 

There is a lot of boat traffic on the Amazon River. Canoes are very common for covering short distances. 
Motorized boats are used for longer distances.

There are only two seasons in Amazonia: the dry season and the rainy season. Each lasts about six 
months. During the dry season, skies are clear for up to 10 hours each day and rain showers are brief. 
During the rainy season, skies are cloudy almost all the time and showers are heavy. There is so much 
rain that the level of the rivers can rise as much as 40 feet in the rainy season. Vast areas of the rainforest
are flooded and navigation becomes more difficult.

The Amazon Basin is about the same size as the United States (without Alaska) or Europe. Twenty per 
cent of all the fresh water on earth (one gallon out of every five) is in the Amazon River. Some of that 
water comes from melting snow high in the Andes Mountains.



People and places of Amazonia
The pictures of the landmarks in The Amazon Trail do not always show how those landmarks look today;
they convey a sense of how the landmarks may have looked during the historical period in which you visit 
them. The pictures are digitized versions of photos that were taken in the Leticia-to-Iquitos area of the 
river in 1992.

People in Amazonia speak many different languages. The official language of Brazil is Portuguese, and 
the official language of Peru is Spanish. There are dozens of Indian dialects; most are based on one of 
five main languages.

Trading is a way of life, especially for the caboclos (the people who live along the river). They commonly 
get things they need by trading fish or items that they collect in the rainforest.

The Amazon Basin's first inhabitants (commonly referred to as Indians) migrated there from the North 
about 10,000 years ago. There were between two and 15 million people in the Amazon Basin when the 
Europeans arrived in the sixteenth century. Today, only about 200,000 indigenous people remain. The rest
died as a result of slavery, disease, and other disruptions to their societies. More than 90 Amazonian 
tribes have died out in the twentieth century.

Most destruction of the Amazon rainforest has occurred as the result of people trying to convert the 
Amazon's natural resources into monetary wealth. A few people, such as executives of big banks and 
corporations, do large-scale projects and, consequently, most of the destruction. Most people who move 
into Amazonia, however, are very poor. They move away from desperate poverty in other parts of Brazil 
and try to carve out a living from the rainforest. In most cases, their condition only worsens.



Fishing in the Amazon Basin
There are at least 2,000 species of fish in the rivers of the Amazon Basin. Many, including some that you 
encounter in the program, are commonly caught for food. Others are caught for the tropical fish market. 
The best place to see fish is at the fish markets in river towns.

Different species of fish live in different habitats and water depths. In The Amazon Trail, all the fish are 
mixed together.

Local people use a variety of methods to catch fish. Harpoons, spears, nets, and traps are all used. Some
Indians use bows and arrows or make a potion that paralyzes fish.



Technical information
As you play, it's a good idea to save your game often. Although the sound and music are enjoyable, you 
may want to turn them off occasionally. 
Choose a topic from the list below and you'll see detailed information about that topic.

How to save a game    

How to load a saved game 

Keyboard shortcuts    



How to save a game
Why save a game? 

· If your computer unexpectedly breaks down, you won't have lost your game.
· You may not have time to finish a game.
· You never know when you might drown, succumb to yellow fever, or be captured by headhunters or 

conquistadors. If you saved your game, you can restart it at a point before disaster struck, change 
your strategy, and perhaps avert the disaster.

A good save strategy is to save your game at every landmark and name it after the landmark. That way 
you can return to a specific landmark and talk to the people there.

1. Press Control-G, or pull down the File menu and choose Save Quest.

2. Type a name, check the directory and then click OK or press Enter. If you type a name that is already 
being used, you will replace the older game with the one you are now saving. Click on the up- and 
down-arrows to see a complete list of your saved games.



How to load a saved game
If you want to play a game you previously saved, you can load it from the title screen. Here's how:

1. Click on Load a Quest.
2. Click on the name of the game you want to load, and then click OK (or press enter). If you decide not 

to load a game, click Cancel.

If you are in the middle of a game and decide to load a previously saved game, here's what to do:

1. Pull down the File menu and choose Open a Saved Quest.
2. Click on the name of the game that you want to load, and then click on the OK button (or press 

Enter). If you decide not to load a game, click on the Cancel button.



What's on the menus
At the top of the game screen are the four pull-down menus listed below. Click on one of the topics below 
for more information.

File menu 

Game menu 

Management menu    

Help menu    



File menu

New Quest Starts a new game. If you are already in the middle of a game, 
you get a chance to save it before you start the new game.

Open a Saved 
Quest

Opens a saved game. If you were in the middle of playing a 
game, you see a dialog box where you can save that game 
before choosing another. 

When you see the Open dialog box, double-click on the name of 
the game you want, or click on the game and then click OK.

Save Quest Saves a game.
1. Type a name for your game in the dialog box. Check the 

directory.
2. Click OK. If you have saved a game with the same name 

before, you will replace the older game with the version that 
you are now saving.

For instructions on going to another disk or folder, see your 
Microsoft Windows User's Guide.

Exit Quits The Amazon Trail.



Game menu
Sound Turns sound effects, including the guidebook entries, off and on.

Music Turns the music off and on.

Time Out Interrupts the game allowing you to take a break. When you are 
ready to continue, click on the Resume button.



Management menu
About Management Summarizes the Management menu commands.

Enable Management Displays a dialog box in which you enter the password 
(dream). After you use this command, its name changes
to Disable Management. If you want to prevent people 
from using the Management menu commands, choose 
Disable Management.

Clear Hall of Shields Lets you remove one or more shields from the Hall of 
Shields.

Options Lets you do three things:
Turn off the sound by disabling the commands on the 
Game menu.
Turn off the music by disabling the commands on the 
Game menu.
Adjust the length of time allowed for fishing. A shorter 
time makes fishing more challenging.

Change Password This command lets you change the password (dream) 
to a word of your choice. Letters, numbers, and 
punctuation marks can be used. Spaces, tabs, and 
special keys (such as Shift and Control) cannot.



Help menu
About Amazon
Trail

Lists the people at MECC who created The Amazon Trail and 
indicates the version number.

Online Manual Gives detailed instructions for using the program.

Quick Help Gives brief instructions for using the program.



Troubleshooting

Installing the Program

Problem Solution

"Not enough hard 
disk space"

Make sure you have enough space available on your hard
disk. The installation program shows the amount of hard 
disk space required.
1. Start the installation to check the amount of space 
required. When you find the information, press Esc to stop
the installation.
2. Choose the File Manager icon from the Main group in 
the Program Manager.
3. Choose the icon for the drive you want to check. The 
number of bytes of free disk space is shown in the status 
bar at the bottom of the File Manager window. This 
number should be larger than the amount of space the 
installer indicates you need. (If the status bar does not 
appear, display it by choosing Status Bar from the 
Options menu.)
4. If there is not enough space, remove unneeded files 
from your hard disk and try installing The Amazon Trail 
again.

"Unknown" error 
message during 
installation 

Data is not being transferred to your hard disk. This may 
be the result of a problem with your hard disk. Contact 
your computer dealer for assistance. 

Starting and Using the Program

Problem Solution

I installed The 
Amazon Trail, but
it doesn't run.

You may have missed one of the installation steps. Follow 
the installation directions in the jewel case exactly.

The program is 
running very 
slowly.

Your system is probably low on memory. If the small light 
on your computer is lit often, you are probably low on 
memory. The light is lit when Windows swaps information 
to the disk to make more room for other information or 
rereads information from the disk. To speed up the 
program, you need to make more memory available by:
· Closing other programs you have open or running. 

These programs may be using memory.
· Consulting your Windows documentation for 

information on freeing up memory or optimizing 
Windows, if closing other programs does not speed 
things up.

The access time 
on my CD ROM is 
very slow. Is there 

Sorry, no. The access time depends upon your CD drive. 



anything I can do 
to improve it?

In the Program

Problem Solution

The Amazon Trail
was running, but 
then it 
disappeared.

You may have clicked outside the game window. The 
game is still running, but it may be covered by another 
window. To return to your game, try one of these options:

If you can see the edge of the game screen, click 
anywhere on the visible part of the game screen.

Press Alt-Esc until the game screen appears and is active.

Press and hold down the Alt key while pressing the Tab 
key to cycle through all of the open programs. Release the
Alt key when you see The Amazon Trail icon.

Sound and Music

Problem Solution

I don't hear any 
sound or music.

Make sure that the sound and music options are turned 
on. If they are, you see a check mark next to Sound and 
Music on the Game menu.

I turned on the 
Sound and Music, 
but I don't hear 
anything.

Check that you have a Microsoft-compatible sound card 
installed and that your sound device is set up properly for 
MIDI sound. If you are sure you have a sound card 
installed in your computer, you may not have installed the 
correct drivers for your card. To install the sound drivers 
for your sound card, follow the manufacturer's directions. 
(As a part of the Windows installation, the following sound 
drivers are installed: MIDI Mapper, Timer, [MCI] MIDI 
Sequencer, and [MCI] Sound.)

To test your sound card and sound driver:
1. Go to the Windows Program Manager and open the 

Main Group.
2. Double-click on the Control Panel. Then double-click 

on MIDI Mapper.
3. Open the Name listing and select a name which 

includes the letters "FM" or "Ext FM." Then click on 
Close.

4. Select the File menu from the Program Manager, 
then select Run.

5. Type MPLAYER canyon.mid in the Command Line 
box and click OK.

6. Click on the Play button (the first lower left button) to 
play the music. To stop the song, click on the Stop 



button. 

If your sound drivers are installed properly and the correct 
MIDI Mapper is selected, you should hear the song. 

If you get an error message from windows ("There are no 
MIDI devices installed on the system" or "The current MIDI
Mapper set-up refers to a MIDI device that is not installed 
on the system"), contact your sound card manufacturer for
set-up instructions.

If you can play the canyon.mid song in the Media Player, 
start The Amazon Trail program. If Music and Sound in 
the Game menu have check marks next to them, you 
should hear the sound and music for the program.



Keyboard Shortcuts
You can use these key combinations as shortcuts.

Control-G Save your game

Control-X Quit the program

Esc From the dream sequence: Go to the title screen



How to get help from the online manual

Click text and hot spots
Whenever you see green underlined text, click that text and you'll jump to the page with information about
that topic. It's a bit like an automatic page turner!
Whenever the cursor changes to a pointing hand, click and you'll magically see more detailed information,
usually in a "pop-up" box. 

Menu bar
Use the menu bar to get around in the online manual.

File lets you open the help file, print a topic from the online manual, change your print specifications, or 
exit from the program.

Edit lets you copy text to the clipboard or annotate a topic by adding comments.

Bookmark lets you mark a page in the online manual.

Help gives you access to detailed information about using Windows online help. Click Help and choose 
How to Use Help to see a Table of Contents. Click the topic you're interested in and you see detailed 
information.

Help file buttons
Contents lets you return to the table of contents.

Search lets you look for specific information in the online manual.

Back lets you return to the previous page of the online manual.

History lets you see a list of the Help screens you recently studied.

<<    >> let you browse through the Help topics.

Try a jump now. Click Contents to return to the list of contents, or click the Contents command on the 
menu bar.

Re-sizing the online manual window
You can keep the online manual open as you play The Amazon Trail. When the manual is open, re-size 
the window and move it out of the way. 

To re-size the window:
1. Point the mouse cursor at the re-sizing box in the lower right corner of the window (you see a 

double-headed arrow).
2. Hold down the mouse button and drag until the window is the size you want.

To move the window:
1. Point the mouse cursor at the Amazon Trail Manual title bar.
2. Hold down the mouse button and drag the window to a convenient position on the screen.

Printing the manual
You can make printed copies of individual topics from the online manual. For instance, it may be helpful to



print the list of activities.

To make a printed copy of a topic:
1. Choose the topic you're interested in from the online manual's table of contents.
2. Pull down the File menu and choose Print Setup.
3. Check the printer options and change if necessary.
4. Pull down the File menu and choose Print Topic.

Opening the manual
There are two ways for you to open the online manual:

1. To open the manual when The Amazon Trail program is not running, open the File Manager and 
double-click the amazon2.hlp icon.

2. To open the manual when The Amazon Trail program is running, pull down the Help menu and 
choose Online Manual.

Hint: For quick access, keep the manual open as you play.



Rainforest activities
If you enjoy The Amazon Trail, you may want to learn more about the real Amazon. Read on to learn 
about things you can do and books you can read.

Rainforest Activities

1. Rainforest terrariums! Build a rainforest in a two-liter soda bottle. Use philodendron cuttings, potting 
soil, and water. Write to: Bottle Biology Project, University of Wisconsin, 1630 Linden Dr., Madison, 
WI 53706.

2. Amazon adventure! Plan an Amazon trip. Contact travel agents to find out about trips there. Look for 
the March/April-1993 issue of Buzzworm -- The Environmental Journal. They have a directory of 
Ecotravel outfitters who lead Amazon expeditions.

3. Letter writing! Write your public officials to find out what their position is on rainforest protection. 
Consult Barbara Lewis's book, The Kids' Guide to Social Action, 1991. It outlines projects and 
samples of letter writing for social causes. See also Betty Miles's book, Save the Earth: An Action 
Handbook for Kids. Alfred A. Knopf, 1991.

4. Raise money for rainforests! Did you know that you can actually buy rainforest land? Contact 
Rainforest Rescue, c/o The National Arbor Day Foundation, 211 North 12th St., Lincoln, NE 68508.

5. Get involved! Write to one of these organizations for more information about rainforests: 

Center for Environmental Education: 624 9th St. NW, Washington, DC 20001
The Children's Rainforest: PO Box 936, Lewiston, ME 04240
National Wildlife Federation, International Programs: 1400 16th St. NW, Washington, DC 20036
Rainforest Action Network: 300 Broadway, Suite 28, San Francisco, CA 94133
Rainforest Alliance: 65 Bleeker St., 6th Floor, New York, NY 10012 
World Wildlife Fund: 1250 24th St. NW, Washington, DC 20037.



Recommended reading

For Pre-Teens
Baker, Lucy. Life in the Rainforests: Animals, People, Plants. Franklin Watts, 1990. A reference book that 
addresses a number of rainforest topics.

Baptista, Lynne Hardie. Discover Rain Forests. Publications International, Ltd., 1992. A large, colorful 
book that introduces rainforest ecology.

Cherry, Lynne. The Great Kapok Tree. Gulliver Books, Harcourt Brace Jovanovich, 1990. An illustrated 
storybook that is considered a modern classic for younger readers.

Dorros, Arthur. Rain Forest Secrets. Scholastic, Inc., 1990. An illustrated introduction to rainforest 
concepts for younger readers.

Flora. Feathers Like a Rainbow: An Amazon Indian Tale. Harper Row, 1989. An enchanting retelling of an 
Amazonia myth.

Forsyth, Adrian. Journey Through a Tropical Jungle. Simon and Schuster, 1988. Description of a 
scientist's expedition in the rainforest of Costa Rica.

George, Jean Craighead. One Day in the Tropical Rain Forest. Simon and Schuster, 1988. An overview of
life in the rainforest as seen in one 24-hour period.

Stone, L. Rain Forests. Rourke Corp., 1989. An introduction for 5th-8th graders.

Taylor, Barbara. Rainforest. A Dorling Kindersley - Look Closer Book, 1992. A colorful overview; one in a 
series of interesting new books.

Willow, Diane. At Home in the Rain Forest. Charlesbridge, 1991. A brief introduction to rainforests, with 
color illustrations.

For Older Kids and Adults
All of these books were used in doing research for The Amazon Trail.

Cowell, Adrian. The Decade of Destruction. Henry Holt and Company, 1990. An account of the work of the
Villas Boas brothers, as well as reports on gold mining, rubber tapping, and cattle ranching in the 1980s.

Eu, Geoffrey, ed. Amazon Wildlife. APA Publications, 1992. An overview of Amazonia. Heavily illustrated. 
Includes information for tourists.

Goodman, Edward J. The Explorers of South America. University of Oklahoma Press, 1992. Stories of 
everyone from Francisco de Orellana to Gene Savoy.

Goulding, Michael. Amazon: The Flooded Forest. Sterling Publishing, 1990. Describes the phenomenon 
of flooded forests; includes detailed information on the fish and other animals that live in this ecosystem.

Hecht, Susanna, and Alexander Cockburn. The Fate of the Forest: Developers, Destroyers, and 
Defenders of the Amazon. Harper Collins Publishers, 1990. An account of what's happened from the 
sixteenth century to the present.

Kricher, John. A Neotropical Companion. Princeton University Press, 1989. A fact-filled book on the 
natural history of tropical rainforests in Central and South America.



McIntyre, Loren. Amazonia. Sierra Club Books, 1991. A blend of human history, natural history, and 
stunning photography.

Historical Adventures
Here's a list of books written by some of the characters in The Amazon Trail. A few of the books are 
relatively new or have been reprinted; these may be available at your bookstore. Most of the books are 
out-of-print and are available only at your library. These books may be hard to find, but the search is 
worth it. If you think Indiana Jones had some adventures in the Temple of Doom, wait 'til you read about 
Teddy Roosevelt on the River of Doubt!

Agassiz, Louis and Elizabeth. A Journey in Brazil. Fields, Osgood & Co., 1869.

Bates, Henry Walter. The Naturalist on the River Amazons. Penguin Books, 1988.

Fawcett, Col. P. H. Lost Trails, Lost Cities. Funk & Wagnalls Co., 1953.

Humboldt, Alexander von. Personal Narrative of Travels. . .(translated and edited by Thomasina Ross). 
Ayer, 1969.

Roosevelt, Theodore. Through the Brazilian Wilderness. Charles Scribner's & Sons, 1921.

Schultes, Richard E. Place Where God Reigns. Synergetic Press, 1988.

Spruce, Richard. Notes of a Botanist on the Amazon. Edited by A. R. Wallace. Macmillan and Co., 1908.

Wallace, Alfred Russel. Travels on the Amazon and Rio Negro. Ward, Lock & Co., 1853.




